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Notices

Trademarks
AJA® and Because it matters.® are registered trademarks of AJA Video Systems, Inc. 
for use with most AJA products. AJA™ is a trademark of AJA Video Systems, Inc. for 
use with recorder, router, software and camera products. Because it matters.™ is a 
trademark of AJA Video Systems, Inc. for use with camera products.

Corvid Ultra®, lo®, Ki Pro®, KONA®, KUMO®, ROI® and T-Tap® are registered trademarks of 
AJA Video Systems, Inc. 

AJA Control Room™, KiStor™, Science of the Beautiful™, TruScale™, V2Analog™ and 
V2Digital™ are trademarks of AJA Video Systems, Inc.

All other trademarks are the property of their respective owners.

Copyright
Copyright © 2024 AJA Video Systems, Inc. All rights reserved. All information in 
this manual is subject to change without notice. No part of the document may be 
reproduced or transmitted in any form, or by any means, electronic or mechanical, 
including photocopying or recording, without the express written permission of AJA 
Video Systems, Inc.

Contacting AJA Technical Support or Sales
Please have all pertinent information at hand prior to contacting AJA support or sales.

	 Support Telephone:	 +1.530.271.3190

	 Support Website:	 https://www.aja.com/support/contact

	 Support Email:	 support@aja.com

	 Sales Email:	 sales@aja.com

	 Shipping Address:	 AJA Video Systems 
		  180 Litton Drive 
		  Grass Valley, CA 95945, USA



AJA and Adobe Applications Quick Start Guide v17.0	 3	 www.aja.com

﻿

Contents
Notices  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                       2

Trademarks .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                            2
Copyright  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                             2
Contacting AJA Technical Support or Sales .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                        2

Chapter 1 – AJA and Adobe Overview  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   4
Adobe Applications Supported  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                               4
Hardware Products Supported  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 4
Supported AJA Hardware Products and Features .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                    5

Chapter 2 – AJA and Adobe Installation  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   8
Software Installation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                      8
AJA Hardware Firmware Update  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 8
OS Configuration .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 9

Chapter 3 – Using Adobe Premiere Pro .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                  10
Video and Audio Support with Premiere Pro .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                     10

Playback Resolution .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                    10
8K and 4K Output in Premiere Pro .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                           10

Options Set in Premiere Pro Preferences .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  10
Audio Preferences .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                     11
Audio Hardware Preferences  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                              11
Playback Preferences  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                   12

Premiere Pro Audio Configurations .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                           14
Example 1: Voice-over with Control Panel Audio Mixer  .  .  .  .  .  .  .  .  .  .  .  .  .             15
Example 2: Voice-over without Control Panel Audio Mixer  .  .  .  .  .  .  .  .  .  .  .           16
Example 3: Voice-over with USB Device and Computer Monitoring  .   .   .   .   .  17

Chapter 4 – Using Adobe Photoshop  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                   18
Video Support with Adobe Photoshop .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  18
AJA Capture  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  18
AJA Export  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  19

Chapter 5 – Using Adobe After Effects .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 20
Video Support with Adobe After Effects  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  20
After Effects Realtime Performance  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  20

Chapter 6 – Audition, Character Animator .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                21
Adobe Audition Audio Support .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                              21
Adobe Character Animator Setup .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                            21



AJA and Adobe Applications Quick Start Guide v17.0	 4	 www.aja.com

﻿

Chapter 1 – AJA and Adobe Overview

Adobe Applications Supported
The AJA Desktop Software package is tightly integrated with the following Adobe 
applications:

•	 Premiere Pro
•	 PhotoShop
•	 After Effects 
•	 Character Animator
•	 Audition

This Quick Start Guide provides information for using an AJA device configured 
for video and audio input and output on a computer running Premiere Pro. 
Similar configuration procedures may also apply for configuring an AJA device for 
use with other Adobe products.

This Quick Start Guide does not provide operational information for Adobe 
applications except as related to AJA hardware operations. Please read the Adobe 
user documentation for Adobe application configuration and operation.

NOTE:	 AJA recommends using the latest AJA software in combination with the current 
version of Adobe applications. For demanding workflows, AJA also recommends 
using the latest OS with up to date high performance host system hardware. See 
the recommended specs per your AJA hardware product Release Notes.

Please be aware that in some cases AJA software may be compatible with macOS 
or Windows versions that are older than those Adobe recommends. In this case, 
when working with Adobe applications, you should follow the recommendation 
of Adobe over the recommendation of AJA.

NOTE:	 Beginning with version 16.1, on macOS, the AJA and Adobe Applications supports 
Apple Silicon, as well as earlier Intel processors.

Hardware Products Supported
AJA in association with Adobe provides a range of hardware that supports Adobe 
applications courtesy of installing the AJA desktop software package:

•	 Io X3, Io 4K Plus, Io IP
•	 KONA X, KONA 5, KONA 4, KONA IP, KONA 1, KONA HDMI, KONA LHi, KONA LHe 

Plus
•	 T-TAP Pro

NOTE:	 Note that the lists above (and in other sections of this guide) may contain 
products that are no longer sold, but which may still work with Adobe 
applications.

Other products may support Adobe Plug-ins in the future. In this manual all 
supported hardware devices are referred to as "AJA hardware".

All features described in this manual may not be available with all AJA hardware. 
For example, Audio Mixer functionality using AJA Control Panel is not available on 
some AJA devices.



AJA and Adobe Applications Quick Start Guide v17.0	 5	 www.aja.com

﻿

NOTE:	 If you wish to execute a Voice Over to Timeline using an analog Mic, but the 
AJA device you are using only has inputs for audio via SDI embedded, HMDI 
embedded or AES, then you will likely require an analog audio embedder and / or 
a digital mixing board, with either having an A to D converter.

Supported AJA Hardware Products and Features
Table 1.  AJA Hardware Feature Summary, Thunderbolt Devices

Io 4K Plus Io X3 T-TAP Pro

Tbolt Ports Tbolt 3 Tbolt 3 Tbolt 3

macOS Intel or 
 Apple Silicon 

Intel or  
Apple Silicon 

Intel or  
Apple Silicon 

Windows √ √ √

Linux

Max Input  
Resolution 

4K 2K

Max Output  
Resolution

4K 2K 4K

SDI In 12G/6G/3G 3G

SDI Out 12G/6G/3G 3G 12G/6G/3G

HDMI In 2.0 1.4b

HDMI Out 2.0 1.4b 2.0

HDR over HDMI √ √ √

HDR over SDI √ √ √

Closed Captions √ √ √

Analog  
Audio In

√ √

Analog  
Audio Out

√ √ √

Control Panel 
Audio Mixer

√ √ √

√ = Supported         (blank) = Unsupported
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Table 2.  AJA Hardware Feature Summary, PCIe Devices 

KONA X KONA 5 KONA 4 KONA 1 KONA 
HDMI KONA LHi KONA LHe 

Plus

PCIe 3.0 
4-lane

3.0  
8-lane 

2.0  
8-lane 

2.0  
2-lane

2.0  
8-lane

1.0  
4-lane

1.0  
4-lane

macOS Intel or 
 Apple 
Silicon 

Intel or 
Apple 
Silicon 

Intel or 
Apple 
Silicon 

Intel or 
Apple 
Silicon 

Intel or 
Apple 
Silicon 

Intel or 
Apple 
Silicon 

Intel or 
Apple 
Silicon 

Windows √ √ √ √ √ √ √

Linux √ √ √ √ √ √ √

Max Input  
Resolution 

4K 4K 4K 2K 4K 2K HD

Max Output  
Resolution

4K 4K 4K 2K 2K HD

SDI In 12G/6G/3G 12G/6G/3G 3G 3G 3G 1.5G

SDI Out 12G/6G/3G 12G/6G/3G 3G 3G 3G 1.5G

HDMI In 2.0 2.0/1.4b 1.3

HDMI Out 2.0 2.0 1.4b 1.3

HDR over HDMI √ √ √

HDR over SDI √ √ √ √

Closed Captions √ √ √ √ √ √

Analog  
Video In

√ √

Analog  
Video Out

 √ √ √

Analog  
Audio In

with KONA 
Xpand

√ √

Analog  
Audio Out

with KONA 
Xpand

with K3G 
box

√ √

Control Panel 
Audio Mixer

√ 4K Mode 4K Mode √ √

 √ = Supported         (blank) = Unsupported



AJA and Adobe Applications Quick Start Guide v17.0	 7	 www.aja.com

﻿

Table 3.  Adobe Application Feature Summary

KONA X / KONA 5 / KONA 
4 / KONA 1 / Io 4K Plus / 

Io X3

KONA LHi / Kona LHe 
Plus T-TAP Pro KONA HDMI

Video Audio  Video Audio Video Audio Video Audio  

In Out In Out In Out In  Out  Out  Out In In 

Apple

Premiere   
(up to 2023) √ √ √ √ √ √ √ √ √ √ √ √

Premiere *  
(after 2023) √ √ √ √ √ √ √ √ √

After Effects √ √ √ √ √ √

Character 
Animator √ √ √ √ √ √ √ √ √

Audition √ √ √ √ √ √

Photoshop √ √ √ √ √ √

Windows

Premiere  
(up to 2023) √ √ √ √ √ √ √ √ √ √ √

Premiere *  
(after 2023) √ √ √ √ √ √ √ √

After Effects √ √ √ √ √

Character 
Animator √ √ √ √ √ √ √ √

Audition √ √ √ √ √

Photoshop √ √ √ √ √ √

* Premiere 2023 is the last version to allow Video Capture
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Chapter 2 – AJA and Adobe Installation

Software Installation
AJA Desktop Software package default installation includes plug-ins for both Mac 
and Windows versions of the Adobe application.

NOTE:	 There is no longer any requirement to separately install the AJA Adobe Plug-ins. 
Performing a Standard Install of AJA Desktop Software, by default, also installs 
the AJA Adobe Plug-ins.

Go to the AJA website and download the latest AJA Desktop Software package  
containing the AJA Control Panel application. 

https://www.aja.com/en/support/downloads/

System software updates may occasionally become available to AJA product 
owners on our website (www.aja.com). We recommend checking occasionally for 
both software updates and additional product information, or subscribe to the 
AJA RSS feed.

IMPORTANT:   Please read the brief Release Notes PDF file that accompanies your AJA 
software. The Release Notes describe important features and fixes.  

Always uninstall previous versions of AJA software before updating your 
computer with new software. Go to your AJA Utilities (on the Mac) or Windows 
Control Panel to uninstall existing AJA software. This helps prevent hardware/
software conflicts.

If your computer has previously had another video capture or multimedia device 
installed, ensure you uninstall any related software before installing the AJA 
Desktop Software package.  This will prevent any hardware or software conflicts. 

You cannot use AJA hardware with Adobe applications until the AJA Desktop 
software has been installed on your computer. Make sure the Adobe software 
is installed and launched at least once on your computer before installing AJA 
Desktop software.

IMPORTANT:   If you install or update a supported Adobe application at a later date, you 
must run the AJA installer program again.

AJA Hardware Firmware Update
After the AJA Software Package has been installed on a computer with your AJA 
hardware installed, the firmware on that AJA device can be updated if a newer 
version of firmware is included with that software package. 

1.	 Open the AJA Control Panel application.

2.	 If more than one AJA device is connected, choose the device you want to 
update by selecting its name from the drop-down menu at the top of the 
screen.
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Figure 1.  Control Panel Screen Showing Multiple AJA Devices

  

3.	 Go to the Control Panel Firmware Screen.

4.	 Select the firmware version (if multiple versions exist) in the Desired 
dropdown.

Figure 2.  Control Panel Screen Showing Multiple Firmware Versions

 

5.	 Click on Install. Messages appear and when finished, firmware update 
completed messages are shown. 

6.	 Click Shutdown to power down the computer.

7.	 Restart the computer. 

8.	 Open AJA Control Panel. The AJA hardware with the updated firmware 
should be recognized by the Control Panel application. 

OS Configuration
In most cases, using AJA hardware with Adobe applications is set and forget. 
Simply set your Adobe application to point at AJA hardware for all input and 
output operations. No need to switch drivers, switch to desktop audio, etc.

NOTE:	 On first use, you will need to tell your operating system to use AJA hardware as 
the default Audio Input and Output device. Consult the manual for your specific 
AJA I/O card, or your OS documentation for more information.



AJA and Adobe Applications Quick Start Guide v17.0	 10	 www.aja.com

﻿

Chapter 3 – Using Adobe Premiere Pro

Video and Audio Support with Premiere Pro
Using Adobe Premiere Pro and AJA hardware together provides comprehensive 
Video and Audio I/O. AJA devices support Monitoring/Output to professional 
monitoring or downstream devices (e.g. recorders/routers/3rd party applications). 
This includes signaling for HDR over SDI and HDMI simultaneously.

Capture of material can be achieved using AJA Control Room:
•	 AJA Control Room can capture HDR metadata along with video and audio, 

then place that within a .mov file recorded to disk.
•	 AJA Control Room cannot perform batch capture for Premiere Pro sequences.
•	 AJA Control Room is not able to perform Voice over to Timeline for Premiere 

Pro sequences.  The Adobe Voice Over to Timeline tool can utilize the audio 
from an AJA device such as analog inputs of the Kona Xpand card or the audio 
from SDI.

Playback Resolution
For best output resolution, use Full as your Playback Resolution setting. Use the 
fly-down menu in the Premiere Pro Source or Program Sequence to set Playback 
Resolution.

8K and 4K Output in Premiere Pro
If you are using AJA Hardware that supports UltraHD2 and/or UltraHD/4K, then 
depending on the Premiere setting chosen, 8K or 4K will be output via SDI. 
If the AJA hardware device you are using does not support UltraHD2 and/or 
UltraHD/4K, then the AJA hardware in Premiere Pro Match Sequence mode will 
automatically output the best resolution available.

Options Set in Premiere Pro Preferences
In Adobe Premiere Pro Preferences (under Premiere Pro > Settings for Mac, and 
under Edit > Preferences for Windows) you can set up global (default) settings.

Windows Setup
In Audio Hardware, Adobe Desktop Audio menu for Windows, select the MME 
Device Class and the AJA Hardware device.

Mac Setup
On a Mac, in Audio Hardware select Core Audio and the AJA hardware device for 
input and output. 

NOTE:	 If you hear static on the AJA hardware output, adjust the audio buffer size in the 
Audio Hardware Preferences. The optimal size may vary for different systems or 
different setups based on CPU, RAM, and running applications.
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Audio Preferences
Figure 3.  Premiere Pro Audio Preferences

Mute input during timeline recording
If you will be performing voice-overs:

•	 Check this box to prevent audio echo and feedback during voice-over 
recording using AJA hardware and the AJA Control Panel Audio Mixer.

•	 Uncheck this box so you can hear the audio being recorded  if you are using a 
USB or a built-in microphone for voice-over recording.

Audio Hardware Preferences
The following setups guarantee accurate AV output sync using the AJA hardware 
for input and output.
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Figure 4.  Premiere Pro Audio Hardware Preferences, Windows OS

  

Playback Preferences
Figure 5.  Premiere Pro Playback Preferences

 

Enable Mercury Transmit

Mercury Transmit must be enabled (checked) in order for Premiere Pro to utilize 
the AJA hardware.
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NOTE:	 Turning Enable Mercury Transmit off is a good way to tell if the external device 
is involved in an issue; if you still have an issue when it is unchecked then the 
problem is not related to the AJA hardware.

See "Premiere Pro Audio Configurations" on page 14 for more information about 
configuring audio.

Primary Audio Device

For Audio Device, select the AJA device you will be using.

Transmit Device Setup
For Video Device, click on the Settings gear icon of the AJA device you want to 
use for video.

Figure 6.  Premiere Pro Preferences Transmit Device Playback Settings

 

Video Format

The default setting (expected to be what most users will want and use) is Match 
Sequence. When Match Sequence is selected, the transmit plug-in will try to put 
the card in a mode that matches the resolution and frame rate of the timeline 
you’re working with. Alternatively, you can use Match Control Panel and then 
select a video format from the AJA Control Panel Format menu. Please refer to the 
Format Screen section of your AJA hardware's Installation and Operation Guide 
for additional information.

NOTE:	 Even with Match Sequence selected, it is possible to make other parameter 
adjustments (such as color space or up/down/cross conversions) using the AJA 
Control Panel.

Buffer Mode

Use the Buffer Mode menu to choose Standard, Minimum, or Maximum frame 
buffering. This mode determines how many frames of buffering are to be used in 
the AJA hardware:

•	 Standard is 4 frames late, which may be close enough for voice-over.
•	 Maximum will store either the maximum number of frames allowed by the 

hardware or 14, whichever is smallest. Not recommended for voice-over.
•	 Minimum is 1 frame early. Required for accurate voice-over recording.

Minimum vs. Standard Mode 

The Minimum setting will provide the best scrubbing and JKL keyboard control 
performance on the timeline. The Standard setting insures that frame drops are 
less likely by providing more frame buffering. It also allows optimum audio sync 
for voice-over recording.

For editing, use Minimum mode most of the time. Then, when mastering a tape 
or playing out live (to air or theater) where no scrubbing will occur, you can switch 
to the Standard mode to avoid frame drops.

For T-TAP Pro users, Standard mode is preferred in both cases.



AJA and Adobe Applications Quick Start Guide v17.0	 14	 www.aja.com

﻿

NOTE:	 Use Standard mode for any projects in which the sequence framerate does NOT 
match the framebuffer framerate. The most common example is using 23.98 
source material but playing out at 29.97.  In this situation a larger than minimum 
buffer size is required for the added 3:2 frame rate pull up. 

HDR Color Space

This setting allows you to define which colorspace Premiere Pro uses for output. 
See Table 1 on page 5 to identify which AJA hardware devices support HDR.

Other HDR Settings

High Dynamic Range video requires use of supported HDR media files, such as 
OpenEXR, ProRes Mov and MP4.

Control Panel settings required for HDR operation include:
•	 Format: RGB-10, RGB-12, and YUV-10
•	 SDI Output: RGB Full (greatest color range) or RGB SMPTE

Premiere Pro Sequence Settings recommended for HDR operation are:
•	 Maximum Bit Depth
•	 Maximum Render Quality

Widescreen Checkbox

Check the Widescreen box if the project is widescreen standard definition NTSC 
or PAL format.

Premiere Pro Audio Configurations
A Premiere Pro session can be configured for audio in different ways. Which 
method you use depends on the audio task at hand, the AJA hardware's audio 
capabilities, and the audio sources to be used. Some example configurations are:

Example 1 - If your AJA hardware supports the AJA Control Panel Audio 
Mixer, you can use the AJA hardware for video and audio input and output 
with optimum A/V sync, including zero latency voice-over recording and 
monitoring. Leaving your system configured this way maintains A/V sync in 
your entire video editing session. 

NOTE:	 In the three examples below, after completing the voice-over you will need to re-
configure your system away from using Adobe Desktop Audio to restore proper 
A/V sync for the remainder of your video editing session. 

Example 2 - If your AJA hardware does not support the Control Panel Audio 
Mixer (for example, LHe Plus and LHi), you can still use the AJA hardware 
for video and audio input and output, including audio monitoring using 
Adobe Desktop Audio. However, zero latency voice-over recording and audio 
monitoring is not available.

Example 3 - You can also completely bypass the AJA hardware for audio input 
and monitoring, using your host computer's audio system and Adobe Desktop 
Audio. The AJA hardware is only used for video, and zero latency voice-over 
recording and audio monitoring is not available.
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Example 1: Voice-over with Control Panel Audio Mixer 
If your AJA hardware supports the Audio Mixer feature you can use one of the AJA 
hardware audio inputs (selected in AJA Control Panel) to add an ultra-low latency 
voice-over track to your project timeline. For example, when using the AJA Io 4K 
Plus, Voice Over to Timeline can make use of Analog Audio In (DB25 Line Level), 
embedded HDMI Audio In, or embedded SDI Audio In. 

Recommended settings for Adobe Premiere Pro when using AJA hardware for 
voice-over using the AJA Control Panel Audio Mixer are:

1.	 Mac or Win OS: Set the Audio / Sound to default to using AJA device for 
both input and output (see "OS Configuration" on page 9).

2.	 Premiere Pro Audio Hardware Preferences (Windows OS only): Set Device 
Class to MME.

3.	 Premiere Pro Audio Hardware Preferences: Set AJA Device for Default Input, 
Default Output and Master Clock.

4.	 Premiere Pro Audio Preferences: Check Mute input during timeline 
recording. This prevents monitoring echoes of the voice-over being 
recorded.

5.	 Premiere Pro Playback Preferences: Select the AJA Device for both the Audio 
Device and Video Device.

6.	 Premiere Pro Playback Preferences/Video Device Setup: Set Buffer Mode to 
Minimum.

7.	 Premiere Pro Timeline: Right click on the microphone Voice-over record 
icon on the desired track on the timeline and choose Voice Over Record 
Settings. Select the AJA Device as the source (see Figure 7). You can see the 
voice-over input levels on the meter, and you can adjust them up or down 
externally from Premiere Pro and AJA Control Panel, using an external 
mixer. 

Figure 7.  Premiere Pro Voice-Over Record Settings

8.	 AJA Control Panel: Audio Mixer Screen/Playback Monitor: Check AJA 
Input, choose from Item Select the AJA device's input to be used, if desired 
check the Main App to hear the already recorded session audio, and adjust 
monitoring levels (see Figure 8). This Control Room screen is active even 
when controlled by an external application.  
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Figure 8.  AJA Control Panel Audio Mixer Screen

 

9.	 In the Premiere Pro timeline, place the cursor on the timeline where you 
wish to begin the voice-over recording, then click on the microphone Voice-
over record icon for the track and record your audio.

These settings simultaneously provide Premiere Pro Voice Over to Timeline with 
full-duplex zero latency monitoring and capture to the timeline. 

Example 2: Voice-over without Control Panel Audio Mixer
Some KONA and Io devices do not support the Control Panel Audio Mixer. You 
can use one of the these device's audio inputs (selected on the AJA Control Panel) 
to add a voice-over track to your project timeline. For example, if your device 
supports analog audio input your source could be a microphone connected to an 
audio mixer, with the line-level mixer output connected to a KONA/Io breakout 
audio input.

NOTE:	 This method should not be used when precise A/V sync is required on the output. 
A slight, measurable delay may be induced.

The settings below are intended for use with an audio input connected to an AJA 
hardware device to perform a voice-over recording without using the AJA Control 
Panel Audio Mixer.

1.	 Mac or Win OS: Set the Audio / Sound to default to use the AJA device for 
both input and output (see "OS Configuration" on page 9).

2.	 Premiere Pro Audio Hardware Preferences (Windows OS only): Set Device 
Class to MME.

3.	 Premiere Pro Audio Hardware Preferences: Set AJA Device for Default Input, 
Default Output and Master Clock.

4.	 Premiere Pro Audio Preferences: Uncheck Mute input during record. This 
allows you to listen to the voice-over recording as it happens, but there may 
be a delay.

5.	 Premiere Pro Playback Preferences: Select Adobe Desktop Audio as the 
Audio Device. This lets you use the current selection in the Audio Hardware 
preferences for monitoring. 
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6.	 Premiere Pro Timeline: Right click on the microphone Voice-over record icon 
on the desired track on the timeline and choose Voice Over Record Settings. 
Select the AJA Device as the source (see Figure 7 on page 15). You can see 
the voice-over input levels on the meter, and you can adjust them up or 
down externally from Premiere Pro and AJA Control Panel, using an external 
mixer. 

7.	 Premiere Pro Timeline: Place the cursor on the timeline where you wish to 
begin the voice-over recording, then click on the microphone Voice-over 
record icon for that track and record your audio.

These settings provide voice-over record and audio monitoring on the timeline, 
but exact A/V sync is not guaranteed. 

IMPORTANT:   When finished with the voice-over recording, return the Premiere Pro 
Preferences (see Step 5 on page 15 above) to use AJA hardware as the playback 
device, to ensure the remainder of your work in the session has the proper A/V 
sync. 

Example 3: Voice-over with USB Device and Computer 
Monitoring

If you wish to use a USB mic or computer audio source and monitor through the 
computer, you can use Adobe Desktop Audio for voice-over and monitoring, 
using use the AJA hardware only for video. 

NOTE:	 This method should not be used when precise A/V sync is required on the output. 
A slight, measurable delay may be induced.

The settings below are intended for use with a USB headset Mic and headphones 
(Logitech headset, for example) to perform a voice-over recording. 

1.	 Mac or Win OS: Set the Audio / Sound to default to use the AJA device for 
both input and output.

2.	 Premiere Pro Audio Hardware Preferences (Windows OS only): Set Device 
Class to MME.

3.	 Premiere Pro Audio Preferences: Uncheck Mute input during record.

4.	 Premiere Pro Audio Hardware Preferences: Set Logitech Headset for Default 
Input, Default Output, and Master Clock.

5.	 Premiere Pro Playback Preferences: Select Adobe Desktop Audio for the 
Audio Device and AJA Device for the Video Device. 

6.	 Premiere Pro Timeline: Right click on the microphone Voice-over record icon 
on the desired track on the timeline and choose Voice Over Record Settings. 
Select Logitech Headset as the source. You can see the voice-over input 
levels on the meter, and you will adjust them up or down externally from 
Premiere Pro and AJA Control Panel (possibly on the USB mic itself). 

7.	 Premiere Pro Timeline: Place the cursor on the timeline where you wish to 
begin the voice-over recording, then click on the microphone Voice-over 
record icon for that track and record your audio.

These settings provide voice-over record and audio monitoring on the timeline, 
but exact A/V sync is not guaranteed. 

IMPORTANT:   When finished with the voice-over recording, return the Audio Hardware 
and Playback Preferences to use AJA hardware, to ensure the remainder of your 
work in the session has the proper A/V sync. 
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Chapter 4 – Using Adobe Photoshop

Video Support with Adobe Photoshop
Using Adobe Photoshop and AJA hardware together provides:

•	 The ability to capture still video frames from professional cameras, software 
and other devices.

•	 The ability to export stills as video frames for Monitoring/Output to 
professional monitoring or downstream devices (e.g. recorders/routers/3rd 
party applications).

•	 Signaling for HDR over SDI and HDMI simultaneously.

Adobe Photoshop accepts Adobe plug-ins and drivers to closely integrate the 
AJA hardware Export function into the application.

NOTE:	 Setup of Input and Output formats for AJA hardware are now performed using 
the AJA Control Panel rather than menus within the Adobe Plug-ins.

AJA Capture
NOTE:	 PhotoShop captures frames of the video being input to the AJA device. An AJA 

device's internally generated Test Pattern cannot be captured by PhotoShop.

With Photoshop open, go to the File pull-down menu and select Import>AJA 
Capture. Selecting AJA Capture performs an immediate capture of the current 
frame in the AJA hardware frame buffer.

Figure 9.  AJA Image Capture in Photoshop, File>Import Menu

If you use the capture function regularly, we recommend that you set up a 
Keyboard Shortcut to trigger the capture (see Photoshop documentation).
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AJA Export
To use the AJA Preview function, go to Export and choose AJA Export.

Figure 10.  AJA Image Export in Photoshop, File>Export Menu

The specific options available to you are determined by the AJA hardware device 
that is installed in your workstation that you are currently controlling. 

Use the AJA Control Panel to set Video Format and Pixel Format for your desired 
output.

Source Frame Setting
To setup Preview options, go to the Window menu and select AJA Preview. Select 
a Source Frame mode to define the video interlace for your image. Progressive is 
the default.

NOTE:	 If your source video is interlaced, you may select the appropriate (lower or upper) 
initial field to maximize AJA hardware output performance. This setting tells the 
AJA hardware which type of frame format it is receiving.

Figure 11.  AJA Photoshop Export Setting Menu 

In Fit To Screen mode, the AJA hardware automatically scales the image geometry 
until one of its borders fills the monitor screen. No cropping or distortion occurs.

When your Export Settings are selected, click on the Export button to output 
your image through the AJA hardware.

NOTE:	 When you output in Video + Key mode (set in AJA Control Panel), Video is output 
via SDI 1 and the Key channel is output on SDI 2. (This does not apply to KONA 4K 
Mode operation, see the KONA manual.)
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Chapter 5 – Using Adobe After Effects

Video Support with Adobe After Effects
Using Adobe After Effects and AJA hardware together provides the ability to 
Monitor/Output to professional monitors or downstream devices. This includes 
signaling for HDR over SDI and HDMI simultaneously.

NOTE:	 While Video and Audio playback is supported via AJA devices, audio / video sync 
when using Adobe After Effects can't always be guaranteed by the application. 
Best practice where possible is to render to RAM for playback with audio.

NOTE:	 Beginning with AJA’s v12.4 Retail Software package, support for Adobe After 
Effects has changed. Previously two different plug-ins were being installed. The 
‘Blithook’ plug-in is the legacy plug-in and is no longer installed by default. It 
must be deliberately chosen as an option in both the Mac and Windows installer. 
The Transmit plug-in is installed with the default installation options.

The After Effects Video Preview Preferences are similar to the Premiere Pro 
Playback Preferences. See "Playback Preferences" on page 12 for more 
information.

After Effects Realtime Performance
RAM Preview should be realtime for HD in After Effects. 4K RAM preview may 
even be possible with a high performance workstation. Please ensure you have 
the following settings for proper RT RAM preview.

1.	 Make sure that the frame buffer format of the AJA Control Panel matches 
the resolution and frame rate of your After Effects Composition. This can 
be set by launching AJA Control Panel, clicking on ‘Format’ in the left hand 
column, and selecting the correct resolution and framerate in the ‘format’ 
drop down menu.

2.	 Next, please ensure that the “Resolution” setting for “Time Controls” is set 
to “Full” in After Effects. If not set to “Full”, the image that the AJA Preview 
Panel receives and sends to the AJA hardware during RAM Preview will not 
be sent at “Full Resolution” and thus will either be software resized to Full 
Resolution before sending to the AJA hardware for display, or will be center 
cropped before sending. 

3.	 If RAM Preview is still not realtime, you can try some of the following – 
setting your Zoom to “100%” in your AE Composition, making sure the 
“Frame Rate” of the AE Time Controls” matches the frame rate of the 
“Primary Format” in the AJA Preview Panel, and muting audio in the AE 
Time Controls.

NOTE:	 In some cases the available bandwidth of the motherboard limits the card's 
ability to output realtime video. AJA tech support can show you how to use 
AJA System Test to test the bandwidth you are getting between the card and 
motherboard.
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Chapter 6 – Audition, Character Animator

Adobe Audition Audio Support
The Audition Audio Channel Mapping Preferences and Audio Hardware 
Preferences are similar to the Premiere Pro Audio Hardware Preferences. See 
"Audio Hardware Preferences" on page 15 for more information.

Adobe Character Animator Setup
Setting up your AJA device with Adobe Character Animator is very similar to 
setting it up with the instructions provided for After Effects.

1.	 In the Header, select Character and then Preferences... 

2.	 After selecting the AJA device for your Audio Hardware's Default Output, 
select Live Output.

3.	 Next, simply check the box next to "Enable Mercury Transmit and Syphon" 
and then select the box for the AJA Video Device you would like to use and 
then click "OK"

Figure 12.  Adobe Character Animator Preferences

 


